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Introduction

FB-7999 is a software plug-in for Microsoft Windows (VST) and Apple macOS (VST/AU) simulating the KORG ®
DW-6000 and DW-8000 synthesizers from the 1980s. It is written in native C++ code for high performance and
low CPU consumption. The main features are:

Two digital oscillators with 16 + 16 different waveforms

Poly and Unison modes

Built-in pseudo-stereo delay

SysEx data communication, import and export

Extended polyphony (up to 64 voices)

MTS-ESP (https://oddsound.com/) dynamic micro-tuning support

Resizable user interface (not “N” version)

All parameters can be controlled by MIDI controllers

Plug-in supports Windows and macOS (32 bit and 64 bit)

FB-7999 is based on the iPlug2 framework maintained by Oli Larkin and the iPlug2 team. Big thanks, guys!!!
Without your work, it would not have been possible to create a resizable FB-7999 user interface.
To resize the plug-in you just grab the yellow triangle at the bottom right of the FB7999 window and drag it. You
can save the current window size using the menu entry “Save Window Size” in the Options Menu.
If you have trouble with the standard version of FB-7999, please install the (soundwise identical) “N” version of the
plug-in which is based on the original iPlug framework.
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Some Words About The FB-7999

Somehow I think I have to write them down. Skip this section if you feel TLDR.
Read This First
I am aware that a simulation of well-known devices such as the DW-X000 series will provoke mixed emotions.
Thus, let me state some facts:

I did own a DW-8000 in the 1990s so I do know what I am talking about.

I know that FB-7999 does not sound exactly like the DW-8000 (thus the “7999”) nor the DW-6000. But it is

close enough for me (not necessarily for you, though).

Yes, the filters of the hardware (realized with custom NJM2069 chips) sound different than the digital filters in

FB-7999 (in my humble opinion: Not necessarily better but different nonetheless).

I purposely designed the user interface of FB-7999 exactly the way it is although it does not meet nowadays

plug-in standards. Welcome to the 80s!

I intentionally did not add the DW-8000 arpeggiator to FB-7999.

If you are an owner of the original hardware you still might want to use FB7999 as a software editor.

Yes, a lot of people were actually asking me to do this simulation.

Now it is up to you to keep FB-7999 on your hard drive or to move it to the trash bin.

The Hows And Whys
As stated above, many folks asked me to build a DW-8000 simulation (someone even suggested that for
reference purposes I could buy a DW-6000 offered on a famous internet sales platform). Originally, I was not very
fond of the idea (both building and
buying it!) because I cannot say that I really miss my old DW-8000, etc. In fact, I thought it would be impossible to
simulate the DW-8000 because I did not have any reference about the mapping of the abstract parameter values
to physical parameter values (How many Hertz is a cutoff frequency of 2 5 ? What is I 3 in terms of attack time?).
But it went the same way as with Fury-800 and I could not stop myself from starting to work on it…
In the mid of August 2021, Gerald Murer from Austria just wrote me a mail where he stated that WhispAir can
sound pretty close to his DW-8000. I also remembered that Ben Martin from Portugal (who suggested & helped
me to do SequencAir) once said that he was in possession of a DW-6000. So I asked both of them whether they
would be so kind to provide me with samples of their devices – a tedious and boring work.
But they agreed and did!
It is important to understand that FB-7999 is not a sample player. Instead, I used the samples that Ben and Gerald
sent me to reconstruct the sound parameters of the original hardware. Plus there are numerous places in the web
where one can find additional reference data and sounds.

General Operation

If you are familiar with the DW-X000 series, most of the following will be familiar, too. However, since FB-7999
aims to simulate both the DW-6000 and the DW-8000 it is worthwhile to read the next sections.
The DW Modes
Although the DW-6000 and the DW-8000 are pretty similar devices there are certain differences which are listed in
the following table. As you can see the DW-6000 features are a subset of the DW-8000 features with the
exception of the Chorus.
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Feature DW-6000 DW-8000 FB-799

polyphony 6 voices 8 voices 8 to 64 voices

waveforms 8 16 16 + 16

Auto Bend no yes yes

MG waveforms 1 4 4

velocity no yes yes

aftertouch no yes yes

effects Chorus digital delay digital delay

But that’s not the end of the story: The shape of the envelopes of both machines as well as many of the parameter
ranges are different, too. Thus a program with identical settings on a DW-6000 will sound different on a DW-8000
and vice versa!

This is where the “DW-6000 Mode” of FB-7999 comes into play. It is activated using the DW-6000 MODE button
(the “DW-8000 Mode” is active if the LED of this button is off) and it switches the internal sound engine
respectively.

All the additional features of the DW-8000 are still in place, and you can even decide which set of waveforms you
want to choose. In the user interface, parameters of the DW-8000 which are not available on the DW-6000 are
displayed in orange instead of the common light-blue, but they are still functional.

Chorus vs. Digital Delay
FB-7999 can emulate the Chorus effect of the DW-6000 using a tweaked version of the digital modulation delay of
the DW-8000. This means that the internal engine of the delay changes with the selected mode, too. However,
there is no automated change of parameters setting the delay to a Chorus except when you load a DW-6000 MIDI
SysEx data dump (see section Importing SysEx Data) or initialize a DW-6000 program (see section Options
Menu).

Selecting a Program
FB-7999 has 64 programs numbered in a weird fashion from 1-1 to8-8. The first digit is called the bank; there are
8 banks (1 to 8) having 8 programs (1 to 8). To select a program from the front plate the PROGRAM NO. button
has to be activated.



Now you can dial in a new program number using the number pad. When you have pressed the first button (the
bank number) the display will show something like 4 – at PROGRAM NO. with a dash indicating that you have to
press another number button
for the program. Using the BANK HOLD function you can “fix” the bank: Pressing a number button will then
immediately select the respective program of that bank. Note that in BANK HOLD mode the dot at PROGRAM
NO. will be lit, for example like 4 . 3 instead of 4 3 . You can also change the program by using the DOWN and UP
buttons. FB-7999 will then step downwards or upwards through the programs.

The FB-7999 adds a field for naming programs (which is not possible on the DW-X000 series) and optional
buttons to step through the programs – this is a convenience function because in parameter mode (see below)
you cannot change the program directly. To activate these buttons you have to check the “Show Prg. Up/Down
Buttons” entry in the Options Menu.

Editing Parameters
Clicking the PARAMETER NO. button switches into parameter mode where you can edit the individual
parameters of a program. Each parameter has a number similar to the program numbers which can be
determined by looking at the lower part of the front plate (for example VCF Cutoff Resonance has the number 3 I
). The display will show the number at PARAMETER NO. and its value at VALUE.

To change the value of a parameter you have to use the DOWN and UP buttons or the edit slider (see below). If
the value of the parameter has changed, the display will show a dot at VALUE.
This is a rather tedious procedure when creating new sounds. With the FB-7999 you can directly select and edit a
parameter by clicking into the parameter list at the front plate. This will either show up a value knob-like control
that can be moved up and down using the mouse or switch-like control.

The Edit Slider
The DW-8000 (but not the DW-6000) has a cool performance feature: When writing a program it also stores the



parameter that is currently selected for edit. The next time you select the program, the parameter to edit will be
restored as well. This way you can choose the most important parameter per program for direct access.
FB-7999 visualizes this “edit parameter” with a green marker. To set the edit parameter just right-click it in the
parameter panel.

MIDI Learn And The Config File “fb7999.ini”
Every parameter of FB-7999 can be controlled by one MIDI controller. If you want to change the assignment of
MIDI controller (CC; MIDI Control Change) to FB-7999 parameter the MIDI Learn function comes in quite handy:
Just click the MIDI Learn button in the Control Section (caption turns red) and wiggle both the MIDI controller and
the parameter you want to assign (you can abort MIDI Learn by clicking the button again). If you want to unlearn
the assignment, right-click the MIDI  Learn button (the label now reads “UNLEARN”) and activate it. Now wiggle
the MIDI controller or the parameter that you want to unlearn. To save the controller assignments use “Save
Configuration” in the Options Menu (see below); they are stored in the fb7999.ini configuration file. The exact
location of this file depends on your operating system and will be displayed when you click on “Reload” or “Save
Configuration”.

Tuning And Micro Tuning
The master tune of FB-7999 can be set using the TUNE silder control. Furthermore, FB-7999 is compatible with
MTS-ESP by ODDSound, a very cool framework for dynamic micro tuning.
For more (and how to get) MTS-ESP plug-ins see https://oddsound.com. If MTS-ESP is active, the current
tuning name will be displayed as a tooltip of the TUNE slider.

Importing SysEx Data
You can import a DW-6000 or DW-8000 MIDI System Exclusive (SysEx; SYX) data file by clicking “Load SysEx
File” in the  Options Menu (see below). Whatever is in the file will be executed by FB-7999.
Typically a SysEx file contains a single program dump – in this case, the parameters of the current program will be
overridden. Since there is no bank dump defined in the DW-X000 world, importing SysEx files containing exactly
64 program dumps will override the contents of all 64 programs (before doing that the user will be prompted if he
wants to continue). Else if the SysEx data contains multiple program dumps, the programs will only be overridden
if a program dump is followed by a Write Program SysEx command.
Note that the DW mode of a FB-7999 program will be set automatically with respect to the SysEx data format
which is a bit different for the DW-6000 and the DW-8000.
Furthermore, importing DW-6000 program data will default parameters that are not available on the original
hardware to “reasonable” values. This includes setting the digital delay to a Chorus effect.

Exporting SysEx Data
You can export a DW-6000 or DW-8000 MIDI System Exclusive data file by clicking “Save SysEx Program File” or
“Save SysEx Bank File” in the Options Menu. The bank file will contain a dump of all 64 programs and can be
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imported as described above.
Receiving And Sending SysEx Data
Any (valid) SysEx data that is sent to FB-7999 will be handled appropriately program dumps and parameter
change requests are executed immediately.

It is also possible to send a program dump to the MIDI output of FB-7999 using the “Send SysEx Program Data”
command in the Options Menu. Note that the SysEx format will be determined by the current DW mode: If “DW-
6000 Mode” is active then the SysEx format will follow the DW-6000 convention and cannot be used for a
DW8000 device (and vice versa for the “DW-8000 Mode”).
If you want to send a SysEx command for any parameter change within the FB-7999 user interface you have to
check the menu entry “Send Parameter Change SysEx” in the sub-menu “Global MIDI Settings…” of the Options
Menu (again the SysEx format follows the current DW mode). This way you can use FB-7999 is a software editor
for your DW hardware.

Options Menu
When clicking on the MENU button, a context menu opens with the following options:

Copy Program Copy the current program to the internal clipboard

Paste Program Paste internal clipboard to a current program

Init DW-6000 Program Initialize the current program in DW-6000 mode

Init DW-8000 Program Initialize the current program in DW-8000 mode

Load Program Load a program file containing a program to FB799
9’s current program

Save Program Save FB-7999’s current program to a program file

Load Bank…

Load FXB Bank File Load a bank containing 64 programs into FB-7999

Restore DW-8000 Factory B
ank A Restore the 64 programs of the original DW-8000 factory bank A

Restore DW-8000 Factory B
ank B Restore the 64 programs of the original DW-8000 factory bank B

Restore DW-6000 Factory S
ounds Restore the original 64 DW-6000 factory sounds

Save Bank Save FB-7999’s 64 programs to a bank file

Load SysEx File Import a SysEx (SYX) data file; see section Importing SysEx Data

Save SysEx Program File Export the current program as a SysEx (SYX) data file; see section Exporting Sy
sEx Data

Save SysEx Bank File Export all 64 programs as a SysEx (SYX) data file; see section Exporting SysEx 
Data

Send SysEx Program Data Send the current program as a SysEx data dump to the MIDI output; see section 
Receiving And Sending SysEx Data

Select Startup Bank Select the bank file that should always be loaded when FB-7999 is started

Load Startup Bank Load the Startup bank file; can also be used to check what the current Startup ba
nk is



 

Unselect Startup Bank Unselect the current Startup bank

Global MIDI Settings…

MIDI Thru Set if MIDI data sent to FB-7999 should be sent through to its MIDI output (store
d in the configuration file)

Ignore Program Change Set if MIDI Program Change data sent to FB-7999 should be ignored (stored in t
he configuration file)

Send Parameter Change Sy
sEx

Set if MIDI SysEx Parameter Change data should be sent to the MIDI output (sto
red in the configuration file); see section Receiving And Sending SysEx Data

Reload Configuration Reload FB-7999’s configuration file

Save Configuration Save FB-7999’s configuration file

Show Page. Up/Down Butto
ns

Set globally if additional Program Up and Down buttons should be displayed in th
e user interface (stored in the configuration file)

Window Size… Change the window size of FB-7999

Save Window Size Stores the current window size to the configuration file so that it will be restored 
on the next loading of FB-7999

Go Online…

Check Online for Update
When connected to the Internet, this function will c
heck if a newer version of FB-7999 is available at f
ullbucket.de

Visit fullbucket.de Open fullbucket.de in your standard browser

Program Editing

Digital Oscillators
FB-7999 features two digital oscillators – each oscillator provides 16 different waveforms and three octaves (16’,
8’, 4’). The levels of both oscillators are set individually. Oscillator 2 can be detuned and set to a different interval
relative to oscillator 1 (minor/major third, quart, quint). There is also a polyphonic portamento function for both
oscillators.

Waveforms
The DW-8000 is famous for its set of 16 (!)
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digital single-cycle waveforms. To avoid aliasing, these waveforms are organized as mipmaps meaning that there
are different wavetables for different pitch ranges:
Waves for higher octaves have a lower frequency content than tables for lower octaves. Of course, the FB-7999
recreates this functionality.

The 16 DW-8000 waveforms.

In the contrary, the DW-6000 features only 8 waveforms. Thus I took the liberty to add 8 more waves including
some standard “analog” waveforms to enhance the overall sound variety. These additional waveforms are
displayed in orange.

The 8 DW-6000 plus the 8 additional waveforms.

Independent of the current DW mode you can always switch between the waveform sets using the 8000/6000
selector underneath the waveform display.
Auto Bend
Auto Bend is a simple “ramp” envelope for the pitch of the oscillators. It can be activated for oscillator1, oscillator 2
or both. It works in two modes: UP or DOWN. “Up” means that at note start the pitch of the selected oscillator(s)
will rise for a given time until it reaches its final (note) value while “Down” means that it will fall. The intensity of
this effect is adjustable, too.
Note that this feature was not included in the original DW-6000 hardware but is available in both DW modes of
FB-7999.

Noise
Make some noise! In addition to the two oscillators, White Noise is the third sound source that can be controlled
with respect to
it’s level.

Filter (VCF)
The lowpass filter (VCF; Voltage Controlled Filter) of FB-7999 has a 24dB/octave characteristic and can be driven



to self-resonance. Besides the standard Cutoff, Resonance, and Keyboard Tracking parameters it features an
individual ADBSSR envelope generator (EG; see below). It is also possible to control the EG intensity (positive or
negative) by velocity information.

Envelope Generators (EGs)
FB-7999 has to ADBSSR envelope generators (EGs), one for the VCF and one for the VCA (Voltage Controlled
Amplifier). The
shape and timing of the EGs depend on the selected DW mode.

While the VCF EG affects the filter cutoff frequency only, the VCA EG controls the level of the current voice played.
The intensity of both EGs can be controlled by the note velocity (note that this is not possible on the DW-6000
hardware).

Modulation Generator (MG)
Apart from the filter and amplifier envelope generators, FB-7999 adds a so-called modulation generator (MG).
This is a low-frequency oscillator that can be routed to the oscillator pitch and/or filter cutoff. It features four
different waveforms (the DW-6000 only has Triangle), adjustable frequency and a delay function. Again, the
frequency settings of the MG depend on the current DW mode since both hardware devices have different
implementations of their MGs.



Digital Delay
The digital delay of FB-7999 has a coarse selector (TIME) and a fine adjustment control (FACTOR) for the delay
time which ranges from 2ms to 600ms – this is what I have measured using Gerald’s device and deviates from the
512ms stated in the original DW-8000 manual.
The feedback parameter of the delay is rather peculiar as it returns the phase-inverted output of the delay unit
back to the delay input. This results in a distinctive sound, especially for short delay times.
The delay brings its own modulation generator with frequency and intensity controls to change the delay time
periodically. Finally one can set the final effect level.

Note that both the DW-6000 and the DW-8000 feature stereo outputs. However, it is debatable whether the term
“stereo” is justified since the difference between left and right is that one output provides the phase-inverted signal
of the delay / Chorus effect while the other output delivers the phase-normal signal. This is a common
configuration for many synth and effect devices of the 70s and 80s (for example the Poly-800) but it leads to the
total annihilation of the effect signal when you mix both channels to a mono sum!
[I remember a gig back in the 90s where the technician routed the “stereo” outputs of my DW-8000 to a mono bus
– I was shocked that the delay signal was completely gone and thought my device to be broken…]

Performance Control Parameters
There are several parameters that set the effect of various performance controls:

Pitch Bend to oscillator pitch and/or filter cutoff.

(Channel) After Touch to oscillator MG modulation intensity, filter cutoff and volume.

Modulation Wheel to oscillator and filter cutoff MG modulation intensity.

Breath Controller to filter cutoff MG modulation intensity.



The last two bullets need some further explanation. The DWX000 devices feature the famous KORG joystick
instead of classic pitch bend and modulation wheels: A vertical upward movement of this joystick controls the
modulation amount of the oscillators (via the MG) while a downward movement controls the VCF modulation
amount. The DWs send the upward position of the joystick using MIDI CC #1 (Modulation Wheel) but the
downward position using CC #2 (Breath Controller). Since most standard MIDI controllers only have one
modulation wheel, the default configuration of the VCF modulation parameter 8 5 can be switched from “Breath
Controller” to “Modulation Wheel” by clicking on the respective label.

Tweaks
As already mentioned in section Digital Delay the DW devices offer a “pseudo” stereo output which can be
enabled or disabled.
Furthermore, FB-7999 allows the number of voices (polyphony) to be eight or more (1, 2, 4, 6, 8, 16, 32, 64).

Key Assign Modes
FB-7999 features four keyboard assign modes:

POLY 1

Standard polyphonic voice scheduling: For a new note FB-7999 tries to allocate the next voice that is not

playing. If no such voice exists the new note will be scheduled to the “oldest” voice. This way the release phase

of stopped notes will be preserved (if possible).

POLY 2

If only one note is played, that note is always scheduled to the first voice (even if this voice is playing the

release phase of the previous note). If more than one note are played the other voices will be used too. This

mode is useful when long release phases should not “smear” the overall sound (this is identical to the KORG



Trident’s keyboard mode 2).

UNISON 1

At most 8 voices are monophonically played at the same time with slight detune (even if the number of voices

is tweaked to be more than 8).

UNISON 2

The same as UNISON 1 but the EGs will not re-trigger when played legato (“single trigger”).

Parameters

Common

parameter ID description

Key Assign Mode 13 POLY 1, POLY 2, UNISON 1, UNISON 2

Edit Parameter 14 Parameter number assigned to edit the slider

Volume 55 Total volume

Master Tune 56 Master tune (± 100 cents)

DW Mode 57 DW-6000 or DW-8000 mode

Wavetable Set 58 Selected wavetables (8000 or 6000)

VCF MG Mod. Source 59 MIDI CC for controlling the VCF modulation (Modulation Wheel o
r Breath Controller)

Digital Oscillator 1

parameter ID number description

OCTAVE 0 g Octave (16′, 8′, 4′)

WAVEFORM 1 12 Waveform (1 – 16)

LEVEL 2 13 Level (0 – 31)



Digital Oscillator 2

parameter ID number description

OCTAVE 7 21 Octave (16′, 8, 4′)

WAVEFORM 8 22 Waveform (1 – 16)

LEVEL 9 23 Level (0 – 31)

INTERVAL 10 24 Interval (1, -3, 3, 4, 5)

DETUNE 11 25 Detune (0 – 6)

Noise

parameter ID number description

LEVEL 12 26 Level (0 – 31)

Auto Bend

parameter ID number description

SELECT 3 14 OFF, OSC1, OSC2, BOTH (0 – 3)

MODE 4 15 UP or DOWN (0, 1)

TIME 5 16 Auto Bend time (0 – 31)

INTENSITY 6 1-1 Auto Bend intensity (0 – 31)

VCF

parameter ID number description

CUTOFF 15 31 Cutoff frequency (0 – 63)

RESONANCE 16 32 Resonance (0 – 31)

KBD TRACK 17 33 Keyboard tracking: 0, 1/4, 1/2, 1 (0 – 3)

POLARITY 18 34 EG polarity: positive or negative (1, 2)

EG INT 19 35 EG modulation intensity (0 – 31)

VCF EG



parameter ID number description

ATTACK 20 41 Attack time (0 – 31)

DECAY 21 42 Decay time (0 – 31)

BREAKPOINT 22 43 BreakPoint level (0 – 31)

SLOPE 23 44 Slope time (0 – 31)

SUSTAIN 24 45 Sustain level (0 – 31)

RELEASE 25 45 Release time (0 – 31)

VELOCITY SENS 26 41 Velocity sensitivity (0 – 7)

VCA EG

parameter ID number description

ATTACK 27 SI Attack time (0 – 31)

DECAY 28 52 Decay time (0 – 31)

BREAKPOINT 29 53 BreakPoint level (0 – 31)

SLOPE 30 54 Slope time (0 – 31)

SUSTAIN 31 55 Sustain level (0 – 31)

RELEASE 32 56 Release time (0 – 31)

VELOCITY SENS 33 si Velocity sensitivity (0 – 7)

MG

parameter ID number description

WAVEFORM 34 61 TRI, SAW, RAMP, RECT (0 – 3)

FREQUENCY 35 62 MG frequency (0 – 31)

DELAY 36 63 MG delay time (0 – 31)

OSC 37 64 Oscillator modulation amount (0 – 31)

VCF 38 65 VCF cutoff modulation amount (0 – 31)

Bend

parameter ID number description

OSC 39 56 Oscillator bend amount (0 – 12)

VCF 40 61 VCF cutoff bend amount: Off/On (0, 1)

Digital Delay



parameter ID number description

TIME 41 11 Delay time coarse (0 – 7)

FACTOR 42 12 Delay time fine (0 – 15)

FEEDBACK 43 13 Feedback amount (0 – 15)

MOD FREQUENCY 44 14 Modulation frequency (0 – 31)

MOD INTENSITY 45 “IS Modulation intensity (0 – 31)

EFFECT LEVEL 46 16 Output level (0 – 15)

Portamento

parameter ID number description

TIME 47 11 Portamento time (0
– 31)

After Touch

parameter ID number description

OSC MG 48 BI Oscillator MG modulation amount (0 – 3)

VCF 49 82 VCF cutoff amount (0 – 3)

VCA 50 83 VCA level amount (0 – 3)

Wheels

parameter ID number description

OSC MG 51 89 Oscillator MG modulation amount (0 – 31)

VCF MG 52 95 VCF cutoff MG modulation amount (0 – 31)

Tweaks

parameter ID number description

“STEREO” 53 96 Pseudo stereo: On/Off (0, 1)

VOICES 54 En Number of voices (1 – 64)

Frequently Asked Questions

How do I install FB-7999 (Windows VST 32 bit version)?
Just copy the files fb7999.dll from the ZIP archive you have downloaded to your system’s or favorite DAW’s VST



plug-in folder. Your DAW should automatically register the FB-7999 VST plug-in the next time you start it.
How do I install FB-7999 (Windows VST 64 bit version)?
Just copy the file fb799964.dll from the ZIP archive you have downloaded to your system’s or favorite DAW’s VST
plug-in folder. Your DAW should automatically register the FB-7999 VST plug-in the next time you start it.
Note: You may have to remove any existing (32 bit) fb7999.dll from your VST plugin folder or else your DAW may
screw the versions up…
How do I install FB-7999 (Windows VST3 64 bit version)?
Just copy the file fb7999.vst3 from the ZIP archive you have downloaded to your system’s or favorite DAW’s VST3
plug-in folder. Your DAW should automatically register the FB-7999 VST3 plug-in the next time you start it.
How do I install FB-7999 (Mac VST / VST3 /AU 64 bit)?
Locate the downloaded PKG package file fb7999_1_1_0_mac.pkg in Finder (!) and do a right- or control-click on
it. In the context menu, click on “Open”. You will be asked if you really want to install the package because it
comes from an  “unidentified developer” (me ). Click “OK” and follow the installation instructions.
What is the “N” version of FB-7999?
The “N” version is the non-resizable version of FB-7999 that should run on almost any older Windows or Mac
machine. So if you have problems with the standard FB-7999 version, this is the one to go for.
Note that the “N” version does not support the VST3 format.
What is the plug-in ID of FB-7999?
The ID is f b 7 9 .
How do I know if a new version of FB-7999 is available?
When connected to the Internet, open the File menu (see section Options Menu) by clicking the MENU icon and
selecting the entry “Check Online for Updates”. If a new version of FB-7999 is available on fullbucket.de the
respective information will be shown in a message box.
How do I resize the FB-7999 window?
Just grab the yellow triangle at the bottom right of the FB-7999 window and drag it. You can save the current
window size using the menu entry “Save Window Size” in the Options Menu.

Documents / Resources
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